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FEATURES
� Demonstrates the Capabilities of the DS2761

Li+ Battery Monitor, Including:
� Temperature Measurement
� Voltage Measurement
� Current Measurement
� Current Accumulation
� Information Storage
� Identification
� Overvoltage/Undervoltage Protection
� Overcurrent/short Circuit Protection

� Interfaces to the Serial Port of a PC Running
Windows 95, Windows 98, or Windows NT
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EVALUATION KIT CONTENTS
2 pc. TSSOP or CSP Evaluation Boards

of different varieties
1 pc. DS9123 Serial Port Adapter
1 pc. RJ-11 Phone Cable
1 pc. DS2761K CD Containing:

DS2761K Evaluation Software
DS2761 Related Data Sheets

EQUIPMENT NEEDED
1. An IBM-compatible PC running Windows 95,

Windows 98, or Windows NT with a CD-
ROM drive and an available serial port.

2. Cables with mini-grabber style clips or the
ability to solder directly to connection pads.

3. A Li+ battery and a power supply and/or load
circuit.

INTRODUCTION
The DS2761K evaluation kit makes performance evaluation, software development, and prototyping with
the DS2761 Li+ battery monitor easy. The evaluation board interfaces to an IBM-compatible PC through
a DS9123 serial port adapter and RJ-11 cable connection. The provided CD-ROM contains all related
data sheets along with the evaluation software, which can be run under Windows 95, Windows 98, or
Windows NT.

The DS2761K evaluation software gives the user complete control of all functions of the DS2761.
Separate control tabs allow the user access to all EEPROM and RAM memory locations, all control
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registers, and real-time updates of all monitored parameters. The software also incorporates a data
logging feature to monitor a cell over time and fuel gauging algorithms to improve remaining capacity
calculations based on specific cell characteristics.

The evaluation board circuit is designed to provide the DS2761 with accurate parameter measurements,
allow the DS2761 to disable charging or discharging, and protect the DS2761 from ESD damage. Kit
demonstration boards will vary as they are improved upon over time. For information on the
demonstration board circuits refer to the DOCS browser page when auto running from the DS2761K CD-
ROM or inside the documentation directory on the DS2761K CD-ROM.

SETUP AND INSTALLATION

BOARD CONNECTIONS
Connections to the TSSOP demonstration board are best made either by soldering directly to the pads or
by using cables with mini-grabber clips. Connections to the CSP board are best made by soldering
directly to the pads. Communication to the TSSOP board can be accomplished either through the RJ-11
jack by connecting the provided standard six conductor phone cord or by wiring directly to the DQ and
PAC- pads. In the latter case, the size of the board can be reduced by snapping off the RJ-11 jack along
the break line, see Figure 1. To utilize the demonstration software, the DQ and PAC- lines must be
connected to the DS9123 communication brick using either of the two methods described.

Figure 1.  Communication Connections

Figures 2a and 2b show the recommended circuits to simulate charging and discharging. The Li+ cell is
connected between the BAT+ and BAT- pads. The battery charger/power supply or circuit load is
connected between the PAC+ and PAC- pads. The evaluation software can be run in either configuration
as long as a cell is connected between the BAT+ and BAT- terminals providing a minimum of 2.5V to
power the DS2761. Some board versions also have connections for the PS and PIO pins. Refer to the
datasheet for the operation of these pins. Leaving them unconnected does not interfere with the operation
of the demonstration board.

      Figure 2a.  Charging Circuit Fig 2b.  Discharging Circuit
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SOFTWARE INSTALLATION
To install the DS2761K software, exit all programs currently running and insert the DS2761K software
CD into your computer’s CD-ROM. The auto run software on the CD will give an option to install
DS2761K or the user can run SETUP.EXE from the setup directory and the installation process begins.
Follow the prompts to complete the installation. The DS2761K software can be uninstalled in the
Add/Remove Programs tool in the Control Panel. After the installation is complete, open the DS2761K
folder and run DS2761K.EXE or select DS2761K from the program menu. A splash screen containing
information about the evaluation kit appears as the program is being loaded.

The Documentation directory also located on the CD contains all relevant data sheets and application
notes on the DS2761 and DS2761K. They are stored in Adobe Acrobat format for easy viewing and can
also be accessed through the help menu after the program starts.

SELECTING THE COM PORT
The first time the software runs, the Serial Port Settings window appears. In this window, select the COM
port to which the DS9123 is attached and the desired communication rate; then hit OK. The DS2761K
software saves this COM port selection and automatically uses the selection each time the program starts.
To change the COM port later, click the Preferences option on the menu bar, select Serial Port Settings,
and then select the appropriate port. To attempt to automatically locate the DS9123, click the Poll Serial
Ports button. Warning—automatically polling for the DS9123 can disrupt other devices connected to your
computer’s COM ports.

MENUS
Several pull down menu options have been provided to simplify use of the DS2761K software for the
user. Their functions are individually detailed below.

FILE MENU

The File Menu allows the user to store information from a file directly into the Device Setup, Battery
Data, and Fuel Gauging Data sections under the Pack Info Tab or take the same Pack Information and
store to a file. These functions do not directly write or read the DS2761. It is still necessary for the user to
store or recall this information to or from the device by issuing a WRITE or READ command under the
Pack Info Tab.
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REGISTERS MENU

The Registers Menu gives immediate access to all four status and function registers of the DS2761.
Selecting any of the registers will open an individual control window giving the user a description of each
register bit and the ability to read or write it. See the protection register window example.

STATUS REGISTER

The present state of all register bits are displayed immediately upon opening the register window. R/W
locations contain a selection field to allow the user to determine their state. Pressing either the APPLY or
OK button in the EEPROM Register or Special Feature Register windows will automatically update and
read the corresponding register inside the DS2761. The Protection and Status registers have default values
stored in user EEPROM addresses 0x30h and 0x31h respectively. Their windows contain extra options to
write or read these locations independently of their registers.

PREFERENCES MENU

The Preferences Menu allows the user to change COM port settings at any time. Edit Preferences opens
the Select Preferences window. See Selecting the COM Port above.
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HELP MENU

The Search option of the Help Menu provides a list of help topics about the DS2761, the demonstration
boards, and this program. Enter a topic in the text field to begin searching through the help library. The
Tutorial option below it contains a quick tutorial animation pointing out the highlights of the DS2761K
program and demonstration boards.

Selecting the Datasheet option will launch your system’s Adobe Acrobat Reader to view the DS2761 kit
datasheet. If Acrobat Reader is not installed on your system, selecting Datasheet will have no function.
Acrobat Reader is a free download and can be found at www.adobe.com.

Selecting the About topic from the Help Menu will open a window containing information about this
program and Dallas Semiconductor.

PROGRAM TABS
All functions of the program are divided under five tabs in the main program window. Left click on the
appropriate tab to move to the desired function page. Located under the Meters tab is all information on
real-time updates measured by the DS2761: voltage, current, accumulated charge, temperature, and all
error flags. The Data Log tab allows the user to store all real-time information including protection
register state to a file. The Memory tab displays the contents of every register and memory location inside
the DS2761 and allows the user to alter the data. The Pack Information tab gives the user the ability to
assign a default device configuration and store that information to the DS2761 and/or a file. The Fuel
Gauging tab uses the cell characterization information stored under Pack Info to maintain a high accuracy
remaining capacity indicator.
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METERS TAB

The Meters Screen displays the latest real-time measurements of cell voltage, temperature, current and
accumulated charge with both analog meter readouts and digital values. The sense resistor value used to
calculate the current reading is shown in the current section. Left click on it or go to the sense resistor
sub-tab under Pack Info to change this value. The Calibrate Offset button in the current section allows the
user to zero the current measurements under the conditions of their circuit. Left clicking this button will
begin the automatic calibration procedure. Calibration should be performed while the pack is
disconnected and there is no current flow. The next 32 readings will be averaged and the offset eliminated
by adjusting the Current Offset Register (location 0x33h) automatically. The process takes approximately
20s.

The user can bring up the Update Current Accumulator window by left clicking the Set CA button. This
window allows the user to enter values for the Current Accumulator Register and Rated Battery Capacity
in mAH. Rated Battery Capacity is used to determine full scale range on the Charge Remaining Meter.
This value is read from the DS2761 location 0x32h (See Pack Information description) and used as the
default upon entering the Meters section. Changing this value from the Update Current Accumulator
window will adjust the Charge Remaining Meter but will not write to the DS2761.

The present states of the Charge Control and Discharge Control pins are shown at the bottom of the
window. These outputs are active low and drive two control FETs allowing charging and discharging of
the cell pack. The Charge Control pin can be controlled manually by left clicking the Disable/Enable
Charging button and will be forced high automatically by either an Overvoltage or Charge Overcurrent
condition. The Discharge Control pin can also be controlled manually with the Disable/Enable
Discharging button and will be forced high automatically by either an Undervoltage or Discharge
Overcurrent condition.
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The present state of each of the four possible flag conditions (Overvoltage, Undervoltage, Charge
Overcurrent, and Discharge Overcurrent) are represented by LEDs inside the voltage and current sections
of the window. The corresponding LED will be green while the flag is in the cleared state. If conditions
cause a flag to be tripped, the LED will turn red and a button will appear that allows the user to clear the
flag provided clear conditions have been met. If conditions for clearing the flag have not been met by the
circuit, clicking the clear button will have no effect.

DATALOG TAB

The Datalog tab allows the user to see the DS2761’s parameter measurements graphed over time. There
are separate sub-tabs for voltage, current, temperature, and accumulated charge. Each graph displays the
last 500 data points collected by the DS2761K software. The sampling interval can be adjusted from 1
second to 15 minutes and can be adjusted from the Sampling Interval Menu at the bottom of the window.
The Clear Graphs button will clear all data from all four graphs, but does not reset the log to file function.

The Log to File sub-tab contains control information for storing all log data to an ASCII file. The default
filename is c:\DS2761K_datalog.txt, but can be modified in the filename text field. The Log Data button
toggles data logging off and on. Data will be stored at the same interval selected for updating the graphs
in the tab delimited format of

 “Time<tab>Voltage<tab>Current<tab>Temperature<tab>CA<tab>Protection Register”

for easy import into a spreadsheet. The most recent 50 samples are displayed in the window for
observation. Warning—the Log Data function overwrites previous file information. Data previously
stored in the file will be lost.
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MEMORY TAB

The Memory Tab gives the user access to all 12 register, 32 EEPROM, and 16 SRAM bytes inside the
DS2761. They are separated into four sub-tabs for convenience. Any value can be modified by clicking in
that address’ text box and typing a new value in hexadecimal format. The Write button will copy the
entire block of data to the corresponding location inside the DS2761 (Scratchpad RAM on the EEPROM
blocks). The Read button will update the entire block’s text boxes with data from the DS2761
(Scratchpad RAM on the EEPROM blocks). Sub-tabs displaying any EEPROM data will also have Copy
and Recall buttons to allow the user to transfer the data between Scratchpad and EEPROM memory
internal to the DS2761. The Permanently Lock Block 0/1 buttons will permanently store the data
currently located in that block’s EEPROM if the LOCK bit in the EEPROM register is set. Otherwise this
button will do nothing. Warning—this data can never be changed once locked. Verify your data first by
issuing a Recall and a Read.
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PACK INFORMATION TAB

The Pack Information tab gives the pack manufacturer the ability to assign default register settings,
device and sense resistor selection, and recommended manufacturer data and fuel gauging information.

The Device Select sub-tab allows the user to choose which device on the 1-Wire® bus to communicate to
and demonstrates the SWAP feature of the DS2761. Clicking on the Find DS2761 Net Addresses button
will begin a SEARCH NET ADDRESS operation on the 1-Wire bus. All DS2761s found on the bus will
be listed in the Net Addresses field. To communicate to any device on the bus, click on its address inside
the Net Addresses field to select it. The program will now use this device for all operations until a
different DS2761 is chosen. Clicking on the Swap to Selected DS2761 button will demonstrate the
features of the SWAP command provided all devices on the bus have both PMOD and SWEN bits
enabled in their status registers. Issuing the SWAP command will cause the selected DS2761 to wake up
and enable its control FETs while simultaneously all other devices disable their control FETs and enter
sleep mode. The user can shut down all devices on the bus by selecting the “Anonymous Net Address” of
0x0000000000000000h that is provided and issuing a SWAP command.

The Device Setup sub-tab shows the current state of all major features of the DS2761. All status
indicators shown here directly mirror their corresponding bits in the Protection, Status, and Special
Feature registers. Clicking on any of the status indicators will open the corresponding register window to
allow editing. See Registers Menu above. The selection fields on the right hand side of the sub-tab set
how the EEPROM backup bits (locations 0x30h and 0x31h) will be programmed when the DS2761 is
programmed with the pack information.
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The Sense Resistor Select sub-tab allows the user to correct the current measurements if a different value
of sense resistor is used. All DS2761s with an integrated sense resistor use 25m�s. If the sense resistor is
located externally, the user should select the external resistor radio button on this tab, then enter the value
of the resistor in m�s in the Sense Resistor Value field and then click the Write Sense Resistor button.
The Find Sense Resistor button opens the Find Sense Resistor window. The user can then determine the
resistance by forcing a known current and measuring the voltage drop with the DS2761. The resistance
value is stored with ¼ m� resolution into the user EEPROM of the device. The program uses this value
to convert the voltage difference from the VSENS+ and VSENS- pins into milliamps. If this value does
not match the value of the external resistor, current measurements will be inaccurate.

The Battery Data and Fuel Gauging Data sub-tabs demonstrate how the pack manufacturer can use the
DS2761s EEPROM fields to store relevant pack information such as assembly date, chemistry, etc. The
fuel gauging characterization data is used by the fuel gauging algorithms in the software. See the Fuel
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Gauging Tab description below. Clicking on the Load Default Pack Info button will enter example data
into the information fields of the Device Setup, Battery Data, and Fuel Gauging Data sub-tabs. To change
any of this information, simply click on the desired text field and enter the new value. Once all data is in
the desired format, click on the Write DS2761 button to copy it to the EEPROM of the DS2761. This
information can also be stored to a file and recalled later using the Load/Save Pack Info buttons.

MEMORY MAP OF PACK INFORMATION DATA
0x20
0x21 Fuel Gauging – Full Point at 0�C

0x22 Fuel Gauging – Full Point difference from 10�C to 0�C
0x23 Fuel Gauging – Full Point difference from 20�C to 10�C
0x24 Fuel Gauging – Full Point difference from 30�C to 20�C
0x25 Fuel Gauging – Full Point difference from 40�C to 30�C
0x26 Last Measured Discharge – Divided by 10 to store in 8 bits
0x27
0x28 Total Accumulated Discharge – Divided by 20 to store in 2 bytes

0x29 Fuel Gauging – Charge Time Estimation Break Point
0x2A Fuel Gauging – Time from Break Point to Full at 40�C
0x2B Fuel Gauging – Time from Break Point to Full at 20�C
0x2C Fuel Gauging – Time from Break Point to Full at 0�C
0x2D Fuel Gauging – Time from Empty to Full at 40�C
0x2E Fuel Gauging – Time from Empty to Full at 20�C
0x2F Fuel Gauging – Time from Empty to Full at 0�C
0x30 Cell Chemistry Manufacturer CE DE
0x31 PMOD RNAOP SWEN
0x32 Rated Cell Capacity – Divided by 10 to store in 8 bits
0x33 Current Offset – Do not overwrite
0x34 Sense Resistor (1/4m� resolution)
0x35
0x36 Date Code – 2 bytes

0x37 Fuel Gauging – Standby Empty Point difference from 0�C to 10�C
0x38 Fuel Gauging – Standby Empty Point difference from 10�C to 20�C
0x39 Fuel Gauging – Standby Empty Point difference from 20�C to 30�C
0x3A Fuel Gauging – Standby Empty Point difference from 30�C to 40�C
0x3B Fuel Gauging – Active Empty Point difference from 0�C to 10�C
0x3C Fuel Gauging – Active Empty Point difference from 10�C to 20�C
0x3D Fuel Gauging – Active Empty Point difference from 20�C to 30�C
0x3E Fuel Gauging – Active Empty Point difference from 30�C to 40�C
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0x3F Fuel Gauging – Active Empty Point at 40�C

The memory map above shows the format in which the data is stored within the device. All static data is
stored in Block 1 while data which might need to be updated  is in Block 0. The pack manufacturer can
now permanently lock Block 1 to maintain data integrity while leaving Block 0 open for access by the
host processor.
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FUEL GAUGING TAB

The final program tab performs a high accuracy calculation of remaining cell capacity using Dallas
Semiconductor’s fuel gauging algorithms. For this feature to function properly, cell characterization data
must be stored in the DS2761’s user EEPROM. See the Pack Information section above. If
characterization data cannot be found, the fuel gauge will not start and an error message will be
displayed. The Relative Capacity number represents what percentage of cell capacity is remaining based
on present algorithm inputs such as temperature, discharge rate, etc. This value is also reflected in the
analog meter. The remaining cell capacity is also displayed in terms of milliamp-hours and Joules under
Absolute Capacity and Remaining Energy, respectively.

The remaining run time is calculated using the Run Time Power Reference input from the user.
Instantaneous current measurements in the user’s application can vary greatly. By using a reference scalar
instead of actual current and voltage measurements, the program produces a stable estimation of
remaining run time. The user should enter the largest expected power draw from the device into the Run
Time Power Reference field for the most accurate estimation.

If this example were part of a fully integrated fuel gauging system, the algorithms would need to be
updated by the host each time the cell was fully charged or discharged in order to maintain long term
accuracy. To simulate this, the user should click the Empty or Full buttons each time the monitored pack
is completely charged or discharged. The Empty button will reset the Current Accumulator to the
expected empty point based on present conditions. The Full button will set the Current Accumulator the
expected full point based on present conditions. The Learn button will reset the expected full point to the
present Current Accumulator value and update the fuel gauging information in the DS2761’s user
EEPROM. In doing this, the algorithms “learn” from previous results and are more accurate in the future.
This tab gives an example only of fuel gauging. For more information on the process of high accuracy
fuel gauging consult Dallas Semiconductor’s fuel gauging application notes.


